A GUIDE TO WRITING TECHNICAL REPORTS

Faculty of Engineering and Applied Science
Memorial University of Newfoundland

Abstract
This guide is designed to help you learn how to format and organize a formal technical report. Each section provides instructional information and guidelines for preparing technical content.

March 23, 2018
Before you start... some tips on document formatting using Word

How to format headings and add a table of contents

Technical reports need to be formatted and organized to allow for easy document navigation. Thus it is important to include numbered sections and subsections as well as a Table of Contents (TOC) in every formal report you write.

To generate an automatic TOC, you need to apply heading styles (found under the Home tab) to format appropriate text in the body of the report as a heading.

- Apply Heading 1 style to each main section (chapter) in the report, and a Heading 2 or 3 style to the various sub-sections within the report.
- To add the TOC, go to References tab>Table of Contents.

Once added, the TOC can be updated to reflect changes made by the author by clicking on the table and selecting Update Table > Update entire table. New headings should now appear in the TOC.

Formatting the “front” and “back” matter sections of your report

The front matter sections (i.e. Letter of Transmittal, Summary, TOC, Introduction) and back matter sections (Conclusions, Recommendations, Reference list, Appendices) of a formal technical report should always start and stay at the beginning of a new page.

To do this, insert a section break at the end of each of these sections, as follows:

Page Layout>Breaks>Next Page.

By doing this, each section you add after the break starts on a new page, regardless of how many times you modify the content of the report.

To reveal any formatting that has been added to your document, select the ¶ button, located in the paragraph group on the Home tab.

To add different page numbers or formats to different sections of your report, see here.
Dear Dr./Professor/Mr./Ms. (name):

[Reason for report]

[Explanation of report contents]

If there are any questions concerning this report, I would be pleased to discuss them with you.

Yours truly,

[signature, by hand]

[Your Name]
Title of report

Submitted to:
[add professor’s name, department, company etc.]
Memorial University of Newfoundland

Submitted by:
Student Name
[add any other relevant identifying info]

Date Submitted
Summary

The summary is a complete synopsis of the report and must be prepared after the report is written. The summary should contain some or all of the following:

- A statement(s) of what the report is about (purpose, scope, problem, background),
- A description of the work undertaken,
- A summary of the results obtained,
- Main conclusion(s),
- Main recommendation(s) and their costs (if applicable).

A summary should not exceed one page for typical student reports, and it should read as a “stand alone” piece. For example, do not refer to acronyms, ideas, and information that cannot be understood until after someone has read the entire report.

The title “Executive Summary” should be reserved for a summary that is written in non-technical language for those who are not the primary readers of the report but who typically oversee or finance the project being described, such as a company executive.

For further information on how to write a summary, click here.
# Table of Contents

Summary ........................................................................................................................................................ i
List of Figures ............................................................................................................................................... iii
List of Tables ................................................................................................................................................ iv
1 Introduction .......................................................................................................................................... 1
2 [Title of first big section (chapter) of the report body]................................................................. 2
   2.1 Sample chapter outline............................................................................................................. 2
3 [Title of second major chapter of the report body]................................................................. 3
4 Other considerations to keep in mind throughout your report .................................................... 3
   Adding figures and tables, sketches and other illustrations to your documents....................... 3
   Adding equations in your report.................................................................................................. 5
5 Conclusions ........................................................................................................................................... 6
6 Recommendations ......................................................................................................................... 7
References .................................................................................................................................................... 8
   Adding citations and a reference list ......................................................................................... 8
Appendix A: [Title of First Appendix] .............................................................................................. 9
List of Figures

This section is sometimes omitted when reports are short and figures are easily found using the table of contents or by browsing. If you have a large number of figures, you should consider adding this list.

Figure 1: Wind turbine array ........................................................................................................................ 4

Note
➢ If there is a citation in a caption (e.g., [1], [2], Janes (2010), etc.), the citation appears in the list of figures generated by Word. Remove the citation by manually highlighting and deleting it.
List of Tables

This section is sometimes omitted when reports are short and tables are easily found using the table of contents or by browsing. If you have a large number of tables, you should consider adding this list.

Table 1: A poorly displayed table of data ..................................................................................................... 4
Table 2: An improved display of data ........................................................................................................... 4

Note
➢ If there is a citation in a caption (e.g., [1], [2], Janes (2010), etc.), the citation appears in the list of tables generated by Word. Remove the citation by manually highlighting and deleting it.
1 Introduction

The introduction is usually the first numbered section in your report and begins on page 1. The pages of front matter that come before it should be page numbered using Roman numerals.

The purpose of the introduction is to provide the reader with all the necessary background information to properly understand the report. It introduces the subject, describes the circumstances leading up to the decision to prepare a report on the subject, and presents the reason(s) the work was undertaken, along with an explanation of any important limitations.

Three main components need to be included in the introduction:

- The **background**, which describes the events leading up to the existing situation, what work has been done on the subject previously and by whom, and why the study or project is necessary.
- The **purpose** defines what the study or project (or report) is to achieve, who authorized it and the specific terms of reference. Objectives may also be described.
- The **scope** outlines any limitations imposed on the project and states who imposed them. Thing such as cost, time, equipment, depth and extent of study methods, and factors to be included or omitted, need to be mentioned, as appropriate. Remember that a statement of scope, separate from the introduction, should not be included unless there is a specific need for it. The scope of the report may also be given in the letter of transmittal and the summary of the report.
- Remember, an introduction does not include any results, outcomes, conclusions or recommendations.

---

For further information on how to write an introduction, click here.
2  [Title of first big section (chapter) of the report body]

The body of the report starts here. Each new chapter should start on a new page and should include a descriptive title that captures what the chapter is about.

Notes:

➢ Before you start writing, plan your content and create an outline.

➢ The outline should consist of a list of all the main topics (main sections) and sub-topics (subsections) required to achieve your overall purpose for writing, as described in the introduction.

➢ Each subsection is a sub-topic that contains information about the main chapter topic.

➢ The number of sections and subsections in your report is highly variable and depends on the nature, depth and breadth of the material presented in your report.

➢ As explained under the Table of Contents section, be sure to apply appropriate formatting to your section and subsection headings.

2.1  Sample chapter outline

This sample shows the main section and subsection outline for a report about the use of metal coatings in industrial applications.

Chapter 2: Industrial Powder Coatings

2.1 Surface Preparation

2.2 Methods of Applying Powder Coatings

2.3 Electrostatic Spray

2.4 Curing

2.5 Advantage & Disadvantages of Powder Coatings

For more instruction on planning your report content and creating an outline, click here.
3  [Title of second major chapter of the report body]

Continue adding main chapters and subsections to your report, as determined by your outline. You may end up re-arranging and re-organizing your content as you proceed but the good thing about creating a detailed outline is that it enables you the freedom to write sections in whatever order you like and then compile them for review and editing. Most good writers don’t write linearly.

There are many decisions that an author must make to create a good report. It is not enough to just “cover” the content. You need to carefully plan and design your content so that the various sections and subsections flow logically from one chapter to the next. You need to continually remind yourself of the purpose for writing, as described in your introduction. To do this, revisit your outline many times during writing to ensure that the flow of ideas presented in your report supports the stated purpose and enables the audience to understand.

4  Other considerations to keep in mind throughout your report

Good visual design is an essential part of the report preparation process. Be sure to format your document consistently - apply consistent spacing, heading styles, font sizes/styles, margins, and justification throughout the entire report. You should also add figures and tables, as appropriate, to help the reader better understand the material.

Adding figures and tables, sketches and other illustrations to your documents.

You need to decide where and when to add figures and tables to your report and, if so, what type and where to locate it.

The following guidelines apply:

- Figures can include drawings, sketches, graphs, schematics, flow charts, diagrams, photographs, etc.
- Each figure or table should be numbered sequentially and include a caption (captions go on top for tables and below for figures).
- If the figure or table has been copied or reproduced from another source, include a citation within the caption.
- Figures and tables should be neat, clear, and readily understood. Large complex illustrations such as folded drawings or large charts belong in an appendix.
- Figures and tables meant to assist the reader in understanding the subject matter belong as close as possible to the point of reference in the text and you must always refer directly to the figure or table in the text. For example, “Figure 1 shows a wind turbine array”. 
Figure 1: Wind turbine array in Ramea, NL [1]

- Make sure that captions are written concisely yet clearly explain what the figure/table represents. Be sure to explain the figure or table content within the body of the report.

- When adding tables, make sure the information is clearly presented. Take a look at the following tables. Table 1 demonstrates how certain entries should not appear in a table. Table 2 shows a better presentation of the same information.

Table 1: A poorly displayed table of data

<table>
<thead>
<tr>
<th>Integers</th>
<th>Monetary values</th>
<th>Text</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1</td>
<td>03</td>
<td>$12.34</td>
<td>Make sure that</td>
</tr>
<tr>
<td>Row 2</td>
<td>9</td>
<td>5.67 dollars</td>
<td>text is</td>
</tr>
<tr>
<td>Row 3</td>
<td>23</td>
<td>890</td>
<td>consistently justified</td>
</tr>
<tr>
<td>Row 4</td>
<td>157</td>
<td>34.5</td>
<td>R or L</td>
</tr>
</tbody>
</table>

Table 2: An improved display of data

<table>
<thead>
<tr>
<th>Integers</th>
<th>Cost ($Cdn)</th>
<th>Text</th>
<th>Units (g/mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1</td>
<td>3</td>
<td>12.34</td>
<td>Make sure that</td>
</tr>
<tr>
<td>Row 2</td>
<td>9</td>
<td>5.67</td>
<td>text is</td>
</tr>
<tr>
<td>Row 3</td>
<td>23</td>
<td>890.12</td>
<td>consistently justified</td>
</tr>
<tr>
<td>Row 4</td>
<td>157</td>
<td>34.56</td>
<td>R or L</td>
</tr>
</tbody>
</table>

For more instruction on how to add figures and tables to your report, click here.
Adding equations in your report

This is an example of an inline equation: \( \sum_{n=1}^{\infty} \frac{1}{n^2} = \frac{\pi^2}{6} \), an equation written within the lines of text.

The equation shown below takes up more vertical space and therefore should be displayed centered between lines of text, as follows:

\[
\int_{1}^{\infty} \frac{1}{x^2} \, dx = 1
\]

Sometimes equations should also be numbered within the document, as shown below. Doing this allows you to refer to them elsewhere in the document without having to write out the equation again. For example:

\[F = \frac{d}{dt}(mv) \quad (1)\]

Elsewhere in the document, you can simply refer to it using the equation number. For example, “Newton’s law applied to the rotational motion of a rigid body is governed by the following equation:

\[\mathbf{T} = l \alpha \quad (2)\]

In the equation (2), variable \(\mathbf{T}\) denotes the torque about an axis of rotation, \(l\) denotes the moment of inertia of the rigid body and \(\alpha\) denotes the angular acceleration.

For more instruction and examples concerning adding equations to reports, click here.
5 Conclusions

When writing a conclusion, you should never introduce new information, results or ideas. Everything presented in the conclusion must have been discussed in previous sections of the report.

Conclusions should:

➢ be as brief as possible and include only the main points drawn from each section of the report
➢ speak to the requirements established in the introduction (background, purpose, scope),
➢ never advocate action (this is reserved for the recommendations section), and
➢ be presented clearly and in a neat format, for example, in point form and/or numbered.

Some important considerations:

Conclusions and recommendations are sometimes inadvertently placed in the same section under the heading Conclusions and Recommendations. This is not advisable because there is a danger that a conclusion may be taken for a recommendation or that a recommendation may be stated loosely or weakly.

Similarly, conclusions and results should not be confused; results are obtained by applying a method or approach to the problem under consideration, conclusions are drawn from the results by applying the criteria or guidelines established in the discussion and the introduction. For example, a study of the condition of all concrete bridges in St. John’s might find that some were in poor condition with cracks, exposed reinforcement steel, spalling, etc. These are results, not conclusions. If criteria are applied such as safety, maintenance, life expectancy, a conclusion might be that certain bridges are in poor condition and have a limited life expectancy.
6 Recommendations

The recommendations section might begin similar to this: Based on the analysis and conclusions in this report, it is recommended that....

The recommendations section presents the preferred plan of action. Normally several courses of action are open, each with advantages, disadvantages, costs, limitations, and ramifications. These should have been previously discussed and conclusions drawn based on the criteria being applied.

In the example of the bridge study previously referred to, it may have been concluded that it will cost $1.3 million to replace a badly deteriorated bridge. To repair the same bridge to an acceptable standard will cost $300,000 now and $20,000 a year in maintenance. The bridge will have to be replaced eventually. The recommendations should state which option is preferred and, briefly, why.

Recommendations should:

- be specific, definite, and clearly stated,
- be strong and advocate action,
- satisfy the requirements established in the introduction,
- follow logically from the conclusions, and
- be presented in a logical order, e.g. importance, chronologically, functionally.
References


Adding citations and a reference list

If any of the information or work included in your report is based on or refers to other reports, documents, texts, images, presentations, discussions, online information, etc. you need to include in-text citations and reference list entries in the report to give proper credit to those other sources of information.

The list of references is only for works cited directly within the report. Documents that have been read, but not directly or indirectly referred to (summarized, paraphrased, or quoted within the report) should not be listed in the References section.

There are numerous citation and referencing styles. Quite often, you will see the IEEE style used in technical reports.

To learn more about citation and referencing, please see the Technical Communications website
Appendix A: [Title of First Appendix]

Appendices contain large, complex drawings, source documents, data, specifications, test results, cost comparisons, etc. This information provides broad base support for what is said in the discussion sections but the report can be read intelligibly without it.

The following criteria apply for Appendices:

- All information provided in an appendix must be referred in the report.
- Appendices appear in the order in which they are first referred to in the report.
- Appendices are considered individual documents; you may continue the page numbering form the body of the report or alternately, appendices may be paginated separately: A-i, A-ii, etc.
- Each appendix is given an identifying letter, e.g., "Appendix A", "Appendix B", etc.

For more information about including and preparing appendices, see here.